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ABSTRACT

Today personal computer are becoming a popular tool
for problem solving in di&erse fields including scientific,
business,medicine, schools, house management etc.. because
they need only normal commercial power, the power dissipation
is very less as compared to other computers and they can be
operated at normal Toom temperature and normal reiative
humidity.

The PRO-325 is a personal compuﬁer of DEC,USA. It is
designed to operate with the following temperature and

humidity ranges:

Temperature 10 to 40°C

Humidity 20% to 80%

The report describes the method of using the PRO-325

personal computer for typing the reports.




1.0 INTRODUCTION

The PRO-325 (Fig.1.1) is a personal computer of Digital
Equipment Corporation,USA. Using P/0S operating system it can
perform various applications like, word processing, accounting,
scheduling, equipment monitoring, use of programming language

etc.

The three main components of the PRO-325 are keyboard
(Fig.1.2), video monitor (Fig.1.3) and the system unit(Fig.
1,47 .

KEYBOARD

The keyboard can be used to send data and instructions to
the computer. It is similar to a type writer keyboard, but it
has additional function keys that control the computer and

edit data.

VIEDO MONITOR
It is a device that the computer uses to communicate with
a user. It shows that a user has requested the computer to

do, and is way on displaying the results.

SYSTEM UNIT

This unit holds the power supply, thé cenfral processor,
and the storage device ( dual diskette driver), which allows
a user to work with two diskettes. Each diskette can store
up to 400Kbytes.

The processor in the system unit is the Digital F11
microprocessor, part of the Digital Equipment Corporation

PDP-11 family of micro-computers.
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Fig. 1-3

System Unit
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The system comes with 51Z Kbytes of memory. The system
power supply provides all of the power for the system unit,

~ keyboard, monochrome video monitor and any additional equip-

ment connected to the system.




2.0 PROBLEM DEFINITION

Word processing, accounting, scheduling etc. are the
applications that may be performed on the PRO-325 personal
computer.

The PRO-325 can be handled by a layman for typing
report, documents etc. For doing this job, he must know
some of the fundamentals of the PRO-325 personal computer.

The purpose of the present work is to help a user
to quickly learn some of the fundamentals of using the PRO-
325. It is intended for the poeple with little or no exper-

ience in computers, but none with the PRO-325.




3.0 METHODOLOGY

The PROSE Text Editor is used for the generation of
memos, reports, programs, and other kinds of text. With
the help of PROSE a user can create, edit, move, replace,

and format the text

3.1 Getting Started

3.1.1  Handling-diskette

Each diskette is encased in a nonremovable, protective
plastic cover. When not in use, a diskette is stored in a
paper envelope. Fig.3.1 and Fig.3.2 show the correct way to

handle a diskette.

When a diskette is used for the first time, it must
be initialized so that the diskette becomes ready for the use.
The following precautions must be observed while

handling a diskette.

= The diskettes must be stored in a diskette storage
box and kept away from dirt,liquid,suniight,heat,
mathces,cigarettes and magnets.

% The exposed surface of the diskette should not be

touched by hand.

5l Inserting a diskette in a diskette drive

On the right side of the front of the system unit
is the duval diskette drive. The drive can hold two diskettes
at a time. When a diskette is in the drive and the system

unit 1s turned on, the drive makes the diskette spin inside
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its cover. The PRO-325 can then read the information that is on
the diskette.

To insert a diskette in to a slot:

& Take the diskette out of its paper envelope.

- Push the diskette drive door until it springs open. Fig.
3.3 shows how to open the door labled 1.

4 Match the orange arrow on the diskette with the orange
strip on the side of the diskette slot in the drive. A
diskette goes in to slot 2 upside down compared to the
way it goes in to slot 2.(Fig.3.4)

* Insert the diskettes gently all the way in to the drive
slot. (Fig:3:5)

* Close the diskette drive door by pressing it.(Fig.3.6)

The following precautions must be observed while inserting

diskette in the diskette drive:

o

* Never open the door of the diskette drive or remove a
diskette while the personal computer is performing a
function. Wait until the PRO has finished doing the
requested function.

* Never remove a diskette when the active light is ON because
when the diskette drive is in use; the appropriate active

light (Fig.3.7) is ON (red).

3.1.3 Starting the PRO-325

Each time when the personal computer is started, the
‘information on the P/0S system diskette is copied in to the
computer's memory.

! The Start up procedure is as follows:
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& Press the power switch, on the system unit, to 'O'(OFF).

% Open the door of the diskette drive 1.

% Insert the diskette labelled P/0S DISKETTE V1.7 SYSTEM in
to diskette drive slot 1 and close the door of the drive.

® Press the power switch, on the system unit,to '1'(ON).

The system unit runs a self test that takes several
seconds. In about 30 seconds, a prompt appears on the screen.
This is the ready prompt. It appears on the screen every time
the personal computer is started. This prompt indicates that
the system is ready for the user to insert an application
diskette.

5 Remove the system diskette and keep it away.
3.2 Use of Function Keys

i HELP Key
The HELP key is pressed when it is not sure what to do.
Information, if available, appears on the screen for
helping the user.

¢ HOLD SCREEN Key
The HOLD SCREEN key is pressed to keep a screen display
from changing. The same key is pressed again tc release
the hold.

% NEXT SCREEN Key
The NEXT SCREEN key is pressed to move forward through
multiple screens of information.

® PREV SCREEN Key
The PREV SCREEN key is pressed to move backward through

multiple screens of information.
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L PRINT SCREEN Key
The PRINT SCREEN key is pressed to print a copy of
whatever is on the screen, if a printer is connected
to the system unit.
* INTERRUPT Key
The INTERRUPT key, with DO key, is pressed to immediately
stop whatever is going on.
R MAIN SCREEN Key
The MAIN SCREEN key is pressed to return to P/0S Service
Menu.
o DO Key
The DO key is pressed to execute the menu choice.
* CANCEL Key
The CANCEL key is pressed to cancel a menu choice.
* SET-UP Key
rThe SET-UP key is pressed to move from one set-up menu

to another.

353 Menu Selection

The PRO-325 uses a combination of hardware and software
to perform its basic functions. There are several way of
getting software to work. Menu selection is one of them.
Menus are the lists from which the services desired by the
user are selected.

Many applications will display a main menu at the
beginning. There may be only one choice on the menu, or
there may be several. For example, the main menu on the P/0S
diskette displays five choices; COPY DISKETTE,DISKETTE

SERVICES,FILE SERVICES,PRINT SERVICES and VIEW STATUS. When
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any one of these is selected, the appropriate menu will be
displayed. The chart shown in Fig. 3.8 shows the menu hiera-
rchy on the P/0S services diskette.

An item is choosen from a menu in one of the following

ways:

i Move the UP or DOWN pointer to the choice in the menu
list and press the DO key.

OR

* Type the highlighted letters (keywords) of the desired
item in the upper or lower case letters and press the
DO key. The user only need to type enough letters of
the keyword to make a unique choice among the keywords
in the menu. If more than the keyword is typed, the
terminal just beeps to inform the user that he does
not need to type any more after this.
The menu disappears after the user has made the

choice. If there is any submenu, it appears; otherwise the

desired application, service or function begins.
Some of the menu offer a list of extra selection by
pressing the ADDTNL OPTIONS key, that provide greater

flexibility.

3.4 Using The PROSE
The PROSE can be used by choosing from menus and by
using some of the function keys on the keyboard. With PROSE,
the prepared text appears on the screen in the same format
as printed on a printer. In addition, the screen display shows
"where pages end for printing, if the user has put in his

own page breaks.( This part of the screen display does not

1.7
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print out).
The PROSE can be categorized as
* Elementry PROSE

# More Advanced PROSE

3.4.1 Elementary PROSE

At first,insert the PROSE diskette in diskette drive 1
when the ready prompt is displayed, and press RESUME key.
Follow the instructions displayed on the screen,insert an
initialized diskette in diskette drive 2 for storing PROSE files.
when the PRO instructs for the same. The PROSE menu appears
on screen. Select the appropriate menu/submenu and start the

work.

** The PROSE Menu
The PRUSE main menu has two submenus:
— Create New File
= Edit an existing file
* Create New File
This menu is selected if a memo or other new text is created.
On the screen the blank space(Fig.3.9) appears. This is for
typing the text. When a file is created, the left margin is
at the first column on the screen, and the right margin is at
the 72nd column. These are the default margins. But they can
be changed.

Paragraphs are separated with a balnk line. By pressing the
'RETURN key,PROSE moves the cursor to the left margin of the next

line. The RETURN key is Pressed twice to begin a new paragraph.

In PROSE, the TAB key, by default, moves the cursor over every

19
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eight columns, starting at column 9.

PROSE also considers the left margin a tab stop. The Additional
Options Personalize Menu is used to change PROSE tab stops. Tab
settings made with Set-up Menu A does not affect the Tab key

in PROSE.

To be compatible with the way PROSE fills text when changes are
made, two spaces must be typed after the end of each sentence.
Any time if an attempt is imade to do something that is not
possible, PROSE displays a messagelon fhe bottom line of the
screen. The RESUME key is pressed to continue after a message

appears or the HELP key is pressed for more information.

* Edit an Existing File

This menu is selected if additions or alterations are required
on an existing file.

When selected from the PROSE main menu, a list of the files in
current volume and directory appears. If the file is in this
directory, the pointer is moved down to choose the required

file and the DO key is pressed.

To choose file from a different directory, press the ADDTNL
OPTIONS Key, select the option, ' Choose a different directory/
volume' and press the DO key. When the directory selection
menu appears, select the desired directory and press the DO
key. When the files selection menu appears, select the file to
be edited and press the DO key.

When the file is displayed on screen, text can be added or

ehanged.
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TYPING OVER EXISTING TEXT

In overtype mode, which is in effect unless ‘the INSERT
HERE key is pressed, the text can be replaced, without deleting
the original text, by typing over it. For doing soc move the
cursor to the spot where over typing is to be done and type
the next text. It replaces the existing text. The text can be

replaced with spaces by overtyping with the space bar.
INSERTINS TEXT WITH '"INSERT HERE' KEY

The INSERT HERE key is used when it is required to insert
new text or spaces into existing,text without erasing the

original text. To insert new text into existing text:

a) More the cursor to the spot where the text is to be
inserted.

b) Press the INSERT HERE key. Any existing text to the right
of the cursor moves temporarily to the next line,leaving
an open space.

c) Type the desired text. The newly inserted text is in
reverse yvideo:

d) When the new text insertion has been finished, press the
DO key. The open space closes up, and the inserted text
is no longer in reverse video.

If the paragraph is word wrapped, the rest of it 'fills'
so that there are no unncessary spaces.

While inserting text in paragraraph that is not word
wrapped, press the RETURN key after the text has been inserted,
to move the cursor to a new line. In this case when the DO

key is pressed, the open space created by pressing the INSERT
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HERE key closes up, but the rest of the paragraph remains the same
same as before.
In Insert mode, the arrow, PREV SCREEN,NEXT SCREEN,or FIND

keys can not be used, to move the cursor around the text.

DELETING SEGMENTS OF TEXT USING 'REMOVE"

By using the REMOVE key a part of already created text can
be removed. To remove the text

a) Using the arrow,PREV SCREEN,NEXT SCREEN,or FIND keys, move
the cursor to any one end of the segment to be deleted.

b) Press the REMOVE key.

c) Usiﬁg the arrow,PREV SCREEN, or NEXT SCREEN keys, move the
cursor to the other end of the segment to be deleted. The
segment can be of any length. The segment becomes highlighted
in reverse video as the cursor is moved.(Press CANCEL to
undo the selection).

d) Press the DO key. The selected text disappears.

If the paragraph is word wrapped, any open spaces created by

the deletion closes up when the DO key is pressed, and the

rest of the paragraph fills.

If the paragraph is not word wrapped, the open space closes
up, but the rest of the paragraph is not changed.

#% The EXIT Menu

To exit from the PROSE, the EXIT key is pressed.

The Exit menu us

SAVE FILE

The 'Save File' is selected to store text file in the current

directory and volume ( or another specified directory and volume)
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If it is selected some questions appear on the screen, if
there are any non default word wrap or margin settings in the
file. The questions aré

'Save special word wrap/margin settings ? (YES or NO)
Type YES ( in upper or Iowgr case letters) and press the DO
key ( or just press the DO keyj unless it is required to
return to only the default settings ( 72-column margins and
word wrap off).

Type NO ( in upper or lower case letters) and press the
DO key to delete non default margin and word wrap settings
in the file the next time when it is edited. The filewill
still look the same if it is printed or transferred, but if
it is edited again, unexpected results will be obtained.

After the answer of word wrap/margin question, a form
appears requesting a file name.

Type the name of the text consisting of one to nine
letters and /or numbers and press the DO key. The file is
saved with name, and the PROSE Menu reappears. At this stage
another file can be begin, or press EXIT to return to the
ready prompt.

The default file type is document (DOC). It is only
necessary to change the type while creating a special kind of
file. The change the file type or directory, press the ADDTNL
OPTIONS key before typing the file name and select the appro-
priate option. While working on a previously created file, -
choosing 'Save file' creates a new version of file. P/0S saves
the previous version as well. The old versions that are no

longer needed can be deleted to obtain more free space.
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PRINT FILE

The 'Print File' is selected to print text on the printer.
When printing begins, the Exit Menu reappears. At this point
the file is still available for fﬁrther editing or for saving.
If print and save both ére required, choose 'Save File' after
choosing 'Print File'. 'Print file' is useful for printing the
current draft of a document. If ' Resume editing current
document' is selected after ' Print file', the printout can be

looked as continuing preparation of text.

LEAVE SESSION WITHOUT CHANGING CHANGES

When ' Leave”seésion saving changes' is selected, the
results of the work done during that session are lost. If
this was the first session on that text,everything entered
is lost, otherwise only the changes énd additions made during

that session are lost. This is useful:

- While experimenting with PROSE to see how it works, so
there is no need to save the typed text.
z While printing a document without saving it.
- When a lot of mistakes are made in the text and therefore
it is necessary to type the text again.
When ' Leave session without saving changes, is selected
the following questions appear:'
'Do you really want to discard edits from this session ?
(YES or NO)'. Type YES (‘using either upper or lower case letters
and press the DO key to leave the session without saving changes
and return to the PROSE Menu. Type NO and Press DO ( or just

press DO) to return to the Exit Menu without losing the changes.

25




RESUME EDITING CURRENT DQCUMENT

'Resume editing current document' is selected to go back to
current editing session. This is useful if idea about editing
has been changed or while using the Exit Menu for printing
whatever has been done so far. When the DO key is pressed, the

working file reappears.

3.4.2 More Advanced PROSE

After using the PROSE for a while, it may be required to use
its full potential. For example, it may be desired to move text
around without retyping, or to search for a particular word
without moving the cursor with the arrow keys, or to inform
PROSE exactly where to end each printed page in the document.

Using the advanced PROSE all these tasks can be performed.

LOCATING TEXT SEGMENTS WITH THE "FIND" KEY

The FIND key is used to place the cursor on the first chara-
cter of a specific text segment. The FIND key is useful to know
what text segment are to be changed, but not where it is in the
document. The repeated instances of the same segment can also
be looked. Since PROSE moves forward through the text to the
next instance of the typed text, it may be desired to place the
cursor at the beginning of the file by using the PREV SCREEN
key or the 'Top of file' additional option.

When the FIND key is pressed, the following prompt appears:

'Enter the text to find and Press DO'

Type the word or group of characters to be found and press

the DO key. If PROSE cannot find the text, the following message

appears:
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'Unable to locate text'
PROSE can only look for a text segment that occurs on one line.
If, for example, the first word of a two word segment is at the
end of a line, PROSE will display the message:
Unable to locate text'
Press the RESUME key to continue after a message appears. Here
the DO key can be pressed to search for the next instance of
the same segment. Every time the prompt appears
' Enter the text to find....... !

Continue this operation till the end of the file is found.
x%* PROSE Additional Options Menus

In addition to the PROSE functions,performed with special
function keys, there are several PROSE editing capabilities
available from the three PROSE Additional Options Menus. F12,
F13 or ADDINL OPTIONS key is pressed to display the menu that
lists the additional option, while entering or editing the text
with PROSE. The menu will appear at the top or the bottom of
the screen, depending on the position of the cursor at the
time or pressing the key for that menu. This enables to see
the work while choosing from the menu. The following table
shows the three menus. If any additional options are not
required, the EXIT key is pressed to return to the next display

# PROSE ADDITIONAL OPTIONS EDIT MENU

While in PROSE, these menus are displayed by pressing the
F12 key. The options on the Edit menu enable to move the cursor
and text segments from place to place in the file. The options

ares * Bottom of file

*# Relocate text
* Top of file

27




BOTTOM OF FILE

The 'Bottom of file' is selected to move the cursor to the last

line of the file.

RELOCATE TEXT,

Sometimes it may be required to move a text segment to another

part of the file, or to copy the same text to several places in

the file. 'Relocate text' helps to do these things. To relocate

a text segment

é) Using the arrow, PREV SCREEN,NEXT SCREEN, or FIND keys ,move

the cursor to one end of the text to be relocated.

| b) Press the REMOVE key.

c) Using the arrow,PREV SCREEN,or NEXT SCREEN keys move the
cursor to the other end of the text to be relocated. The
text segment becomes highlighted in reverse video.

(The key CANCEL may be pressed to cancel the selection and
to return to the text display).

d) Press the DO key. The highlighted text disappears.

e) Using the arrow, PREV SCREEN, or NEXT SCREEN keys,move the
cursor to the location where the segment is to be relocated.
If it is required to put the text back in the original place
in addition to relocating the text, leave the cursor position-
ed from where the text has been removed.

f) Press the F12 key

g) choose 'Relocate text' and press the DO key. PROSE moves the
next to the new location.

Jh) If the text is not filled properly , use "Fill text".
i) The text can be relocated as many times as required(until

the REMOVE key is pressed again) by moving the cursor to the
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next place where the text is to be relocated, by choosing'Re-

locate text' from the Edit Menu, and by pressing the DO key.

TOP OF FILE
The 'Top of file' is selected to move cursor to the top line
of the file.
* PROSE ADDITIONAL OPTIONS PERSONALIZE MENU
Fhis menu is display by pressing the F13 key while in PROSE.
The options on the Personalise Menu enable to set the defaults
which are saved until changed again. The options are:.

* Columns 80/132

* Define a key

* List defined keys
* Set tab stops

* Status line ON/OFF

_COLUMNS 80/132

When 'Columns 80/132' is selected and the DO key is pressed,
the number of columns on the screen display changes. If the
display was set to 80 columns, it changes to 132 columns. If
the display was set to 132 columns, it changes to 80 columns.
DEFINE A KEY

Using 'Define a key' menu up to 250 keystrokes can be performed
with the pressing of a single key. Eight keys (F17,F18,F19,F20,
PF1,PF2,PF3, and PF4) are user-definable. The keystroke speci-
fied can include characters, RETURN and the function keys.

To define a key:

a) Move the cursor to the point where it is required to begin
typing, that will be assigned to a user-de finable key.

b) Press the F13 key
c) Using the arrow keys move the pointer to 'Define a key'

d) Press the DO key




ST oL i S S i R R T R R T e e e

e) Type the key sequence that will be assigned to one of the
definable keys.

f) The professional will beep if an attempt is-made to enter
more than 250 keystrokes into a key definition.

g) Press the DO key after typing the key sequence. Or press
the EXIT key if, the sequence just typed(assigned to a
user-definable key) is not required at all. Any typed text
will remain on the screen.

h) At the prompt, type a name for the sequence. This name can
be upto 60 characters long, and can include letters, numbers
spaces and punctuations.

i) Press the key to which the sequence is to be assigned;F17,
F18,F1Y,F20,PF1,PF2,PF3, and PF4 are availabie for this
purpose. A list on the screen shows which keys are already
defined. A key can be re-define, if required.

Now, any time in PROSE,if a just defined function -key is
pressed the key sequence assigned tc that key will be dis-
played. When a defined key is pressed it will begin typing
any text at the current cursor location. If the text
extends beyond the right margin unexpected results may be
obtained.

The best method for learing the many ways so that user-
definable keys can be used is to spend more some time
experimenting with them. Here are some possibilities:

* Use the REMOVE and DO keys, define a key to open up a blank
line

* Using the INSERT HERE and RETURN keys, define a key to-open

up a blank line

* Using the underscore and vertical line characters, define

30
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a key to draw a box or use slaches and backslashes to
create triangles and diamonds.

= Replace one word that appears many times in document
with another word ( for example, replace 'January'
with 'February'). Once a key has been defined to do
this, an otherwise tedious choice becomes a simple
fast and precise operation. Use the FIND,REMOVE
INSERT HERE and DO keys.

% Define a key to choose an additional option. from the
Edit, Personalize, or Format menu. Or define a key to
choose several additional options at one time.

LIST DEFINED KEYS

'List define keys' displays a list of user-defined keys that

have been created with 'Define a key'. Only keys that have

been defined are shown on this menu.

SET TAB STOP

The 'Set tab stops' can be used to establish the columns where

the cursor will stop, each time the TAB key is pressed. The

tab stops set in PROSE will not affect other P/0OS services.

With the initial default setting, there is a tab stop at every

8 columns, starting at column9. For example, if the cursor

is in a column from 1 to 8, when the TAB key is pressed, the

cursor jumps to column 9. When 'Set tab stops' is selected a

ruler appears on the screen. Small diamonds above the ruler

show the current tab stops. Using the arrow keys, move the
cursor across the ruler, to where a tab is required to be

set ; then press the SELECT key. To remove a tab stop, move

the cursor to the diamond which represents the tab stop to be
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removed and press the SELECT key. After selecting all the
desired tab stops, press the DO key.
ADDITIONAL OPTIONS

Pressing ADDTNL OPTIONS displays a menu of the following

options:
* Clear all tabs
#* Reset tab stops
= Tab stop every 8 columns

'"Clear all tabs' removes all tab stops.

'Reset tab stops' resets the tab stops settings that were in
affect choosing 'Set tab stops'

' Tab stop every 8 columns' sets the tab stops to every 8
columns,beginning with column 9.

STATUS LINE ON/OFF

By initial default,22 lines of the text are displayed on the
screen. Lines 23 and 24 are reserved for the status line.

a) Press the F13 key.

b) Choose 'Status line ON/OFF'.

To display the status line again, this procedure is repeated
again
*PROSE OPTIONS SET MENU

This menu is displayed by pressing the ADDTNL OPTIONS key while;
in PROSE. The options on the Format Menu enable to specifidy the

appearance of text in the file. The options are

Centexr line

Fill text
Margin change/word wrap
Page break
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CENTER LINE

To use 'Center line' move the cursor to the line to be centered
and select ' Center line' from the Format Menu. After pressing
the DO key PROSE enters the line within the margins set for

the paragraph.

FILL TEXT
The 'Fill text' is used to wrap paragraphs that allow word wrap.

To fill text:

a) Using the arrow,PREV SCREEN,NEXT SCREEN,or FIND keys,

move the cursor to the beginning of the paragraph to

be filled.
b) Press the ADDTNL OPTIONS key.
c) Choose 'Fill text'
d) Press the DO key

The paragraph fills. The cursor is at the end of the filled
text. 'Fill text' will not operate on text set to 'no wrap'
which is the default setting. Use ' Margin change/word wrap'
to set word wrap on for a paragraph. To get rid of spaces of

paragraphs that are not wrapped the REMOVE key can be used.

MARGIN CHANGE WORD/WRAP

While creating text with PROSE, the left margin is set to column
1 and the right margin to column 72. Word wrap is off for each
entered paragraph. These are the default settings. (A blanck
line i.e. two carriage returns marks a separation between
paragraphs). Word wrap is very useful PROSE feature that
automatically drops and word extending beyond the right margin

to the beginning of the mext line. There is To. need to press
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the RETURN key when the right margin has occurred. The word
wrap should be OFF for entering tables, columns of text,

or programs.

To change margins or the word wrapp settings for a paragraph,
'Margin change/word wrap' is selected. PROSE uses the new
setting(s) for the selected paragraph and for subsequent
paragraphs, moving forward through the text, untill a change
is made or untill there is a change saved from a previous

editing session.

At the time of exit from the session, PROSE asks whether to

save these word wrap and margin settings or not.
To set margins or word wrap:

a) Using the arrow, PREV SCREEN,NEXT SCREEN,or FIND keys,
move the cursor to the first line of the paragraph or
text for which to change margins and /or word wrap.

I1f the paragraph has not yet been typed, before changing
in the setting, press the RETURN key twice to indicate

a new paragraph. If the cursor is moved to a line within
a paragraph, PROSE creates the new margin setting,
starting from where the cursor is, but does not insert

a blank line.

b) Press the ADDTNL OPTIONS key.
c) Select ' Margin change word/wrap'.

d) Press the DO key.

A ruler appears in the text display. Each dot or number on

the ruler represents a column. The 'V symbols mark the location
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of the left and right margins.

e) To set a new left margin, move the cursor to the desired
column and press the SELECT key. (The EXIT key can be
pressed to cancel the choice and return to the text
display).

f) The cursor is moved to the 'V' marking the location of
the right margin. Move the cursor to the desired column
and press the SELECT key. The SELECT key can be used
to toggle back and forth between margins till the

satisfactory settings are obtained.

g) = To change the word wrap setting, press the ADDTNL OPTIONS
key. A menu appears the word wrap possible word wrap
settings; the current word wrap setting is indicated with
a diamond. Move the pointer to the choice and press the

DO key. The margin ruler will again be obtained.

i) Press the DO key to leave ' Margin change/word wrap'.

If changes are made in the margins on a wrapped paragraph.
PRUSE rewraps the paragraphs so that it fits within the new
margins. To find out the word wrap and margin settings for any
paragraph, move the cursor to 1t and look at the status line.
For formatting numbered lists, move the left margin to the
right, and then put the numbers to the left of the left margin.
For example, set the lett margin to column 5, then use the
pointers to move the cursor to the left to this margin. Type
the 1list numbers at column 1, Start the text of the list at
the left margin. Subsequent lines of text will align at

column 5.
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PAGE BREAK

A page break marks where the text should begin printing on the
next page. With an LQPO2 or LA10C-PC printer, print services
can print out a set number of lines for each page. To insert
special page breaks using 'Page break' on an LQPO2 or LA100-PC
printer, the printer 'Top margin' is set to 1 and 'Bottom

margin' to the same number as 'Page length', For using a

LA50 printer, the page breaks are inserted for every page.
lo insert a page break:

a) Using the arrow, PREV SCREEN,NEXT SCREEN, or FIND keys,
move the cursor to any spot on the first line to be

printed on the next page.

b) Choose 'Page Break', (The EXIT key can be pressed to cancel

the procedure and return to the text display).

c) Press the DO key. A double line appears, showing where

the page will break.

The page breaks, in the text, are set after all edits have been
made because a change in the text can affect the page breaks.
When printing files,P/0S causes the printer to jump(form feed)
to the next page on encountering a page break. The double line
that appears in the screen display is not printed on the paper
copy. PROSE considers a page break the start of a new paragraph.
To delete an existing page break, move the cursor to the page
break and press the key that is used for deleting the charac- '

ters.

36




e T
4.0 CONCLUSION
The PRO-325 personal computers can be used as a
popular tool for problem solving in various fields. The report
has illustrated the method of using the PRO-325 personal
computer for typing reports. This report will help a person
who has little/no experience with the computer Or no experience

with PRO-325 but little experience with any other computer.
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GLOSSARY
Application ( or application program)

A computer program that meets some specific user need.
For example, an application program can control an inventory

or monitor a manufacturing process.

Auxiliary Keypad
The set of keys on the far right of the Professional
Keyboard. Some applications interpret these keys as special

function keys; with other applications these keys do nothing.

Backup
To copy one or more files on a diskette for safe
keeping, in case the original diskette gets damaged or lost.

It is good practice to backup all new or newly revised files.

Block

A group of characters or words stored on a diskette
as a unit, in binary format. A block has 512 bytes (roughly
512 characters).P/0S measures the size of a file and the

available storage on a diskette in blocks.

Computer-Based Instruction
Instruction taken by reading display on a computer

screen and typing in responses when requested.

Cursor
The blinking rectangle or undersco¥e on the monitor
screen that shows where the next typed character will appear,

if appropriate.
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Default
Information that the professional assumes as input if

it is not explicitly provided.

Digital Command Language(DCL)
An application provided with P/0S, which enables the
user to manipulate his files and directories by typing commands

instead of choosing from menus.

Directory

A group of files stored on a diskette. A directory
can include all or only some of the files on the diskette.
When a diskette is initiallized, P/0S creates a directory

called USERFILES. User can also create his own directories.

Diskette
A magnetic, file-storage medium, also called a floppy
disk. Diskettes or the Professional are 5 1/4" in diameter

and are encased in a protective cover.

Diskette Drive
A unit that hclds and operates one or more diskettes.
All professional's have a dual diskette drive capable of

holding two diskettes.

Editing Keypad
The set of gray keys between the main keyboard and the
auxiliary keypad. Like the keys of the auxiliary keypad, these

keys can function differently for different applications.

Editor

An application program that allows a user to create and
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modify text files. The user can change text with the Profess-
ionals editor(PROSE) by choosing commands from a menu and by

using function keys.

File

A collection of information treated as a unit. A file
‘'may contain a memo, a program, or other information. Its
fundamental purpose is analogous to that of a conventional
office file. A file is the means by which information 1is
stored on a diskette so that it is efficiently usable by both
P/0OS and a user. A file occupies one or more blocks on a

volume and has a file name.

Form
A request for information that is displayed on the
Professional screen when P/0S requires information that a user

provides.

Function

A type of key on the Professional keyboard that, when
pressed, instructs P/0OS or a P/OS application to do something
specific. The HELP,DO, INTERRUPT,HOLD SCREEN,PRINT SCREEN,and
arrow keys perform the same function all the time. Other
function keys, such as PREV SCREEN, RESUME, CANCEL,EXIT,ES,
F17 and so on, have functions that depend on the application

currentt¥ in use.

Hardware
The physical equipment that makes up a computer system.
Host ( or host computer)

A computer whose resources can be shared several individual
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users at other computers that are connected to the host by
communication lines and hardware. With the PRO/Communications,
a Professional user can connect to a host computer. Once
connected, the user can transfer files to and from the host and
use the Professional as it it were a terminal attached to the

host.

Initialize

To set up(format) a volume so that P/0S can store and
retrieve files on that volume. When initializing a volume,
P/0S erases any information already on the volume. In addition,
~ the initialization process creates a name(supplied by the
person who initializes) for the volume and an empty directory

called USERFILES.
Kilobyte (KB)

Roughly a thousand bytes(actually 1024 or two blocks).

A Professional diskette holds 400 kilobytes of information.

Megabyte (MB)

Approximately a million bytes(actually 1024 squared).

Overtype mode
The way PROSE handles what a user type in a file unless
the user uses the INSERT HERE key. In overtype mode, PROSE

deletes existing text if the user types over it.

P/0S
The Professional's operating system. An operating system

is the set of internal programs that run a computer.
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Program
A sequence of instructions used by a computer to perform

specific operations.

Prompt
A request displayed on the screen for the user to type in
certain information. On menus, a prompt appears on a line

brlow the menu list.

PROSE

The. editor supplied with P/OS.

Ready prompt

The message on the Professional screen that tells the user
to insert an application or service diskette and press RESUME.
It is displayed after system start up, and after exiting

an application or service.

Scrolling
The movement of lines of text up or down the monitor

sCreen.

Software

The collection of programs and information associated
with a computer
Status display

A screen display that shows status information about
P/0S.
Volume

A generic name for a magnetic,file-storage medium, such

as a diskette.
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Word Processing

The manipulation of words and text with a computer.

Word wrap
With PROSE, the automatic dropping to the next line of
any word typed by the user in that extends past the right

margin of his text.

Write-protect tab

An adhesive tab that, when applied to the write-protect
notch on a diskette, prevents from changing or deleting any
file on the diskette. It is necessary to remove the tab to

create, change, or delete any files on the diskette.

44




	00000001
	00000002
	00000003
	00000004
	00000005
	00000006
	00000007
	00000008
	00000009
	00000010
	00000011
	00000012
	00000013
	00000014
	00000015
	00000016
	00000017
	00000018
	00000019
	00000020
	00000021
	00000022
	00000023
	00000024
	00000025
	00000026
	00000027
	00000028
	00000029
	00000030
	00000031
	00000032
	00000033
	00000034
	00000035
	00000036
	00000037
	00000038
	00000039
	00000040
	00000041
	00000042
	00000043
	00000044
	00000045
	00000046
	00000047
	00000048

